
EVM User's Guide: INA233EVM
INA233 Evaluation Module (Rev B)

Description
The INA233 evaluation module (EVM) is an easy-
to-use platform to evaluate the main features and 
performance of the INA233. The EVM supports 
onboard current measurements up to 10A and higher 
currents can be measured with external resistors. The 
EVM can be used with the TI-SCB to interact with the 
online graphical user interface (GUI) to read and write 
to device registers.

Features
• GUI support to read and write device registers as 

well as view and save results data
• EVM detached from SCB for custom use cases
• Multiple EVM support with single SCB/GUI
• Conveniently powered from a common micro-USB 

connector through the SCB
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1 Evaluation Module Overview
1.1 Introduction
This EVM user’s guide describes the characteristics, operation, and use of the INA233 evaluation module 
(EVM). This EVM is designed to evaluate the performance of the INA233. Throughout this document, the terms 
evaluation board, evaluation module, and EVM are synonymous with the INA233EVM. This document includes a 
schematic, reference printed circuit board (PCB) layouts, and a complete bill of materials (BOM).

1.2 Kit Contents
Table 1-1 lists the contents of the EVM kit. Contact your nearest Texas Instruments Product Information Center if 
any component is missing.

Table 1-1. Kit Contents
ITEM QUANTITY

INA233EVM test board 1

Note that this EVM requires the TI Sensor Control Board (SCB), which is sold separately.

1.3 Specification
The INA233 device is a current, voltage, and power monitor with an I2C™-, SMBus-, and PMBus-compatible 
interface that is compliant with digital bus voltages from 1.8V to 5.0V. The device monitors and reports values 
for current, voltage, and power. The integrated power accumulator can be used for energy or average power 
calculations. Programmable calibration value, conversion times, and averaging when combined with an internal 
multiplier enable direct readouts of current in amperes and power in watts.

The INA233 senses current on common-mode bus voltages that can vary from 0V to 36V, independent of the 
supply voltage. The device operates from a single 2.7V to 5.5V supply, drawing a typical supply current of 310µA 
in normal operation. The device can be placed in a low-power standby mode where the typical operating current 
is only 2µA. The device is specified over the operating temperature range between –40°C and +125°C and 
features up to 16 programmable addresses.

Table 1-2. Device Summary

PRODUCT
DIGITAL 

PROTOCOL
ADC 

RESOLUTION
MAX GAIN 

ERROR
MAX OFFSET 

VOLTAGE
INA233 I2C 16-bit 0.1% ±10µV

2 Hardware
This section summarizes the EVM subsystems and components.

2.1 Current Sensing IC
This section describes the INA233 and supporting components.

U1 is the INA233 current-sensing device. C1 and C2 are bypass capacitors that are placed near the sensor to 
help mitigate power supply noise and provide current quickly to the device when needed. LED D1 with current 
limiting resistor R4 are used to indicate when the EVM is powered on.

The device pins can be monitored directly through the test points TP1 – TP12. Note that there are two extra test 
points on GND for convenience.

2.2 Current Sensing Operation
The EVM can be used with either an onboard or external shunt resistor. To use the onboard shunt resistor, 
solder a 2512 surface-mount technology (SMT) shunt resistor across the pads of R1, and connect the resistor 
in series with the external system and load current through J1. An external shunt can be connected directly 
across the terminals of J1. There are two terminals each for IN+ (J1 pins 5 and 6) and IN– (J1 pins 3 and 4) for 
convenience.
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2.2.1 Detailed Setup

To configure a measurement evaluation, follow these steps:
1. Connect a shunt resistor by perform either of the following:

a. Solder a 2512 resistor across the pads of R1 that connects the IN+ and IN– inputs.
b. Connect an external shunt across the IN+ and IN– terminals of J1, preferably across pins 4 and 5, as 

shown in Figure 2-1 and Figure 2-2.
i. If an external shunt is used, make the connections such that the sensing location is across the shunt 

and that there is no high current on the sensing path. See the TI Precision Labs - Current Sense 
Amplifiers: Shunt Resistor Layout video for more information.

2. Connect the IN+ and IN– terminals in series with the load while powered off.
a. When measuring more than 10A, make sure the high current path does not go through the EVM 

(including the terminal block J1), as shown in Figure 2-1.

Load Current Line IN+ Load Current Line IN-

Figure 2-1. IN+ and IN– Wiring for More Than 10A
b. When using 10A or less with either an onboard or external shunt, the current path can be passed 

through the EVM. Figure 2-2 shows a convenient way to use the multiple IN+ and IN- terminals with an 
external shunt for this use case.
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Load Current Line IN+ Load Current Line IN-

Figure 2-2. IN+ and IN– Wiring for 10A or Less

WARNING

When measuring current, first make sure that the equipment (shunt resistor, wires, connectors, 
and so on) can support the amperage and power dissipation. Secondly, make sure that the 
current flowing through J1 does not exceed 10A. Failure to do so can result in damage to the 
EVM, or personal injury.

The EVM can get hot.

3. Connect the VBUS terminal (J1 pin 2) to the desired bus voltage (likely either IN+ or IN–).
a. If VBUS and dependent features are not being used, this channel can be used as an ADC input for 

another voltage.

4. Connect the system ground to the GND terminal (J1 pin 1).
5. Power on the system, and observe the device states and outputs through the GUI.

2.3 Input Signal Path
This section describes the circuitry of the input signal path.

J1 is the main connection terminal. Pin 1 of J1 is used to tie the system ground to the EVM ground. Pin 2 of J1 
is used for the VBUS measurement within the sensor. Pins 3 and 4 are tied to IN–, and Pins 5 and 6 are tied to 
IN+. There are two pins each for IN– and IN+ for convenience.

R1 can be used for an optional onboard shunt resistor with a 2512 footprint. Alternatively, a shunt can be placed 
across the IN+ and IN– terminals of J1. If desired, a differential voltage can be applied directly for measurement 
tests.

C3, R2, and R3 combine to make an optional input filter. R2 and R3 are populated with 0Ω resistors by default. 
When using input filtering, take into account the input bias current of the device. C3 can also be used without R2 
and R3 to reduce noise. See the data sheet for more information on input filtering.
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2.4 Digital Circuitry
This section describes the digital circuitry around the device.

J2 and J3 are the main header pins that connect the digital and power pins to the SCB Controller or other EVMs. 
J3 connects to the EVM/SCB on the right, while J2 connects to more EVMs on the left. R5 and R6 are used as 
pullup resistors for the main digital IO pins.

SW0 and SW1 set the I2C address of the device. This setup can be useful when using the EVM with a custom 
controller (other than the SCB Controller), or when connecting multiple EVMs together. The SCB Controller and 
GUI are set up to use four EVMs at a time.

R8 is used as a pullup resistor for the ALERT pin. LED D2 and current limiting resistor R7 are used to indicate 
when the ALERT has triggered. U2 is an open-drain buffer that forwards the alert signal to J2 and J3 without 
allowing the signal to propagate from the ALERT bus to the device. This feature is primarily used when working 
with multiple EVMs, so that the individual ALERT LEDs can be seen on each EVM while still using the ALERT 
bus. C4 is a bypass capacitor placed near the buffer to mitigate power supply noise and to help provide current 
quickly to the device when needed.

3 Software
3.1 Quick Start Setup
The following instructions describe how to set up and use the EVM.

1. Purchase an SCB.
a. To use a PAMB Controller instead, see PAMB Compatibility.

2. Download the following driver and install as an administrator: https://www.ti.com/lit/zip/sbac253.
a. Follow the download prompts, a myTI™ account is required.
b. Note that this driver is labeled as a PAMB driver, but is also used for the SCB.

3. Attach the EVM to the SCB Controller as shown in Figure 3-1.
a. Refer to Figure 3-2 when connecting multiple EVMs of the same type together.

4. Connect the EVM to the PC using the provided USB cable.
a. Insert the micro USB cable into the SCB Controller onboard USB receptacle J2.
b. Plug the other end of the USB cable into a PC.

5. Access the GUI from this link in either Chrome™, Firefox™, or Safari™: https://dev.ti.com/gallery/info/
CurrentSensing/INA233EVM_GUI/.

6. Connect the GND reference of the external system to the GND node of the EVM (pin 1 of J1).
7. Provide a differential input voltage signal to the IN+ and IN– nodes by connecting the signal leads to J1 pin 5 

or 6 and J1 pin 3 or 4 on the EVM as explained in Current Sensing Operation.
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3.2 EVM Operation
To use the EVM with the SCB Controller (sold separately), connect the EVM as shown in Figure 3-1.

Figure 3-1. EVM (Left) Connected to SCB Controller (Right)

If using multiple EVMs, connect them as shown in Figure 3-2. Make sure to use a different I2C address for each 
device. The GUI supports up to 4 EVMs in total.

Figure 3-2. Multiple EVMs Connected to SCB Controller

3.2.1 Setup
3.2.1.1 Driver Installation

Download and install this driver: https://www.ti.com/lit/zip/sbac253. This is a one-time step per computer, and 
requires a myTI™ account. Note that this driver is labeled as a PAMB driver, but is also used for the SCB. Unzip 
the folder and run the .exe file with administrator privileges.

3.2.1.2 Firmware

Firmware updates are pushed through the GUI if the previous driver is installed. Downloaded offline GUIs only 
update the SCB Controller with the latest firmware available at the time of download. To check for the latest GUI 
or Firmware updates, launch the latest GUI version from the web browser.
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3.2.1.2.1 Firmware Debug

If the firmware must be manually reinstalled for any reason, follow these steps to reinstall the firmware. Make 
sure the EVM is connected to the SCB.

1. First, see if the GUI can program the firmware manually.
a. Plug in the SCB controller to the PC.
b. Launch the GUI.
c. It is possible that the MCU has already entered Device Firmware Update (DFU) mode. If so, the GUI can 

provide a notification and try to update the firmware to the latest version.
d. If the GUI does not update automatically, go to File > Program Device...
e. If the Program Device button is grayed out, make sure the device is connected in the bottom left corner 

before programming.

2. If Step 1 is unsuccessful (or if the Program Device button is still grayed out), manually configure the MCU 
on the SCB Controller to be in DFU Mode. This can be done through either of the below methods with the 
SCB Controller powered on:
a. Through software:

• Send the command bsl on the USB Serial (COM) port of the SCB.
b. Though hardware:

• For safety, turn off and disconnect all load sources and external voltages.
• While shorting the two test points labeled DFU (shown in Figure 3-3) with a pair of tweezers (or wire), 

press and release the reset (RST) button.

Figure 3-3. Test Points Used to Enter DFU Mode Manually

• If the PAMB board is being used instead, these test points are located near PK1 and PK2.

With the MCU in DFU mode, the firmware can now be uploaded through the method outlined in Step 1.

3.2.1.3 GUI Setup and Connection

You can access the GUI from this link in either Chrome, Firefox, or Safari: https://dev.ti.com/gallery/info/
CurrentSensing/INA233EVM_GUI/.

3.2.1.3.1 Initial Setup

To set up the GUI the first time:

1. Make sure that the proper driver is installed successfully so that the GUI can update the EVM firmware, if 
necessary.
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2. Check to make sure the EVM/SCB Controller unit is plugged into the PC, then go to the previously-provided 
GUI link.

3. Open the GUI Composer application to launch the GUI from the web browser (see Figure 3-4).

Figure 3-4. GUI Composer Application

a. The GUI link brings up all versions of the GUI. The newest version available is recommended.
b. For first-time GUI Composer setup, follow the prompts to download the TI Cloud Agent and browser 

extension (see Figure 3-5). These prompts appear after closing the README.md dialog box.

Figure 3-5. TI Cloud Agent
4. To download the GUI for offline use, click the  icon in the GUI Composer application and follow the 

prompts (see Figure 3-4).

3.2.1.3.2 GUI to EVM Connection

To connect the GUI to the EVM, follow these steps:

1. Setup and launch the GUI as described in Initial Setup.
a. Make sure to connect the EVM to the SCB before powering on.

2. Close the README.md file page to initiate a connection between the EVM and the GUI. If successful, the 
Hardware Connected message is visible near the bottom-left corner of the GUI.
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Figure 3-6. Hardware Connected

a. A green indicator with the device type and the text DEVICE CONNECTED is also visible near the top left 
of the GUI.

Figure 3-7. Device Connected
b. If the Hardware Connected and DEVICE CONNECTED text do not show in the GUI, long-press the 

reset (RST) button on the EVM to try again.
i. If that option does not work, check different hardware COM ports under Options > Serial Port.

Figure 3-8. Change Serial Port

c. If the hardware still does not connect, check to make sure the correct GUI/EVM combination is being 
used.
i. If the correct GUI/EVM combination is being used, the firmware of the SCB needs to be 

reprogrammed as described in Firmware Debug.
ii. Many connectivity issues can be addressed by performing one of the following actions:

1. Long-press the reset (RST) button on the EVM with the EVM and SCB connected to each other.
• Refreshing the GUI can also sometimes help.

2. Connect the EVM to a different USB port.
• Avoid using long cables and USB hubs.
• If a desktop PC is being used, try a USB port on the back.

3.2.2 GUI Operation

Setup, launch, and connect the GUI to the EVM per GUI Setup and Connection. Refer to the following sections 
for a description on how to use each page of the GUI.

3.2.2.1 Homepage Tab

The GUI starts on the homepage tab. Click the  (Home) icon on the menu to the left to return to the 
homepage tab at any time.

From the homepage, successful connection of the GUI to the EVM connection can be confirmed (see GUI to 
EVM Connection). The homepage tab also provides access to helpful resources through the buttons on the 
bottom (see Figure 3-9).
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Figure 3-9. Home Tab Links

Software www.ti.com

10 INA233 Evaluation Module (Rev B) SBOU299 – MAY 2026
Submit Document Feedback

Copyright © 2026 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SBOU299
https://www.ti.com/feedbackform/techdocfeedback?litnum=SBOU299&partnum=INA233EVM


3.2.2.2 Configuration Tab

To perform the initial setup for each connected EVM, click the  (Configuration) icon on the menu to the left. 
Figure 3-10 shows an example of the configuration tool.

Figure 3-10. Configuration Tool

From the configuration page the number of EVMs in use can be set, and then for each EVM, you can indicate 
the physical hardware switch settings and configure the shunt and CURRENT_LSB. Table 3-1 describes each of 
the options and fields on this page.

Table 3-1. Configuration Settings and Fields
Setting or Field Description
Number of EVMs • This setting is used to tell the GUI how many EVMs are connected to the SCB.

• Note that the SCB and GUI only support up to four INA233EVMs at a time.
• Changing this setting in the configuration page also changes the same setting in the Results Data tab.

Selected EVM • This setting indicates which EVM settings is currently being changed.
• This setting also selects the EVM that is connected to the Registers tab.

Hardware Switch Settings • Set these settings to match the physical switch settings on the EVM.
• Note that this setting needs to be set before changing any other settings on this page. The GUI blocks the 

other settings until this is set.
• Changing this setting here also changes the same setting in the Results Data tab.

Shunt/Current 
Configuration

This section is used to input shunt information as well as to help calculate the CURRENT_LSB and set the 
CALIBRATION register. Table 3-2 describes how to use each field.
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Table 3-2. Shunt Configuration Settings
Field Description
RSHUNT • Input the value of the used shunt resistor in mΩ.

Max Expected Current • Input the value of the maximum expected current across the shunt resistor in Amps.
• If the Max Expected Current field is left blank, then CALIBRATION can be adjusted manually, and the tool 

indicates the True Max Current that can be measured with the EVM.

CURRENT_LSB • This is the calculated CURRENT_LSB value in Amps. This field gets populated automatically from the 
Max Expected Current field.

• This field can be changed manually if desired, and the changes filter downward.

CALIBRATION • Calculated value for CALIBRATION based on RSHUNT and CURRENT_LSB. When this field changes, 
the value is automatically written to the CALIBRATION register.

• This field can be changed manually if desired, and the changes filter downward.
• Changing this value from the register map page also changes the value here.

True CURRENT_LSB • This is the actual CURRENT_LSB value in Amps back-calculated from the CALIBRATION register with the 
given shunt resistor value.

• This is the value used for calculations in the Results Data section.

True Max Current • This is the maximum measurable current in Amps based on the VSHUNT and CURRENT registers, using 
RSHUNT and the True CURRENT_LSB for calculations.

Required Sensing Range • This shows the required sensing range to measure the Max Expected Current with the specified shunt 
resistor.

• If a Max Expected Current is not specified, then the True Max Current field is used instead.

3.2.2.3 Registers Tab

To view and edit the device registers, click the  (Registers) icon on the menu to the left. The Registers tab 
appears similar to the tab shown in Figure 3-11.

Figure 3-11. GUI Registers Tab
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From the GUI Register Tab, device registers on the EVM can be read and written to. Here are some important 
notes:

• Use the Selected EVM drop-down menu at the top to choose which device to work with on the register map.
– Note, changing this selection also changes the same setting for the Configuration tab.
– Functionally, this setting sets the default read or write address in the MCU and then reads all register 

values back to update the register map. Note that if the data is being collected at a high frequency, then 
this can cause a minor delay in the data collection. For optimal performance, set device settings before 
starting data collection.

• By default, all changes are automatically written to the device. If desired, the Immediate Write setting can be 
changed to Deferred Write to only allow writing when needed.
– The writable register values can be modified using any of these methods:

• Through the widget settings in the Field View section on the right.
• Changing the Value directly with either hex or decimal values.
• Double-clicking on any individual bit.

– Press the  icon to trigger a conversion in triggered mode.

• This requires Immediate Write to be set.
• Turning on Auto Read only updates registers in the register map, and not the plots in the Results Data 

section.
– Leaving Auto Read on while collecting data for plots can interfere with data collection timing.

• The register bit fields are displayed with all 56 bits by default, but can be truncated for readability, select the 
Truncate Bitfields check box to truncate the bit fields to 24 bits.

• For questions about a register or register bit field, select the  icon. Check the device data sheet for further 
information about individual registers or register bit fields.

• For convenience, register settings can be saved and loaded back later to any device with the same register 
map. To do this, go to File > Register Data, as shown in Figure 3-12.

Figure 3-12. Save and Load Register Settings

– Press the Read All Registers button after loading data to update the register map with the actual device 
values.
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3.2.2.4 Results Data Tab

To view and collect result data over time, click the  (Results Data) icon on the menu to the left. Figure 
3-13 shows part of the results data page for reference, which can look different depending on the number of 
connected EVMs.

Figure 3-13. Results Page and Settings

The following is a description of how to use the buttons and settings at the top of the Results Data tab and next 
to each plot.

Table 3-3. Results Data Tab Buttons and Settings
Button or Setting Description
Results to collect/show • Use this section to select which register values to collect data for. If a results register is unselected before 

the COLLECT DATA button is pressed, then the plot below is hidden and the EVM does not try to read this 
register during the collect cycle (even if the conversion is enabled).

• If one of the settings is disabled while the EVM is collecting data, then the plot does not show, but data is still 
being collected and the plot is updated in the background. Simply reselect to show data.

Number of EVMs • Set the Number of EVMs drop-down menu to the number of EVMs currently in use.
• See Figure 3-2 for how to attach multiple EVMs together.
• Changing this value also changes the same setting in the Configuration tab.
• The GUI only supports up to four INA233EVMs at a time.
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Table 3-3. Results Data Tab Buttons and Settings (continued)
Button or Setting Description
Switch settings
(EVM 1, EVM2)

• Use the onboard switches to select a different address for each EVM.
• Set the Switch settings in the GUI to match the setting for each connected EVM.
• EVM 1 is automatically populated with the lowest addressed device unless a setting has already been 

selected.
• Changing this setting also changes the same setting in the Configuration tab.
• If more than one device is being used, a * symbol appears next to the selected EVM that is being used on the 

register map and configuration tabs.
• Changing the switch settings of any EVM sets that EVM as the selected EVM.

Collect Data • Press the COLLECT DATA button to start data collection.
• In this mode, the MCU reads and sends the selected result values for each device over a USB BULK channel. 

All results from one device are read before moving on to the next device. All result values from all EVMs 
together are considered one "sample set".

• Although other registers can be read and or written to through the register map page while collecting data, this 
can adds a delay to the data being collected.

• Press the STOP COLLECT button to stop collecting data.

#Samples Only • If this check box is selected, then the GUI automatically stops collecting data after the number of samples 
specified in the #Samples box has been collected.

• If not selected, the GUI continues collecting data and only store the most recent number of samples.

Delay between samples • Sets the delay between the start of each sample set.
• Desired delay time cannot be obtained if the time is set faster than the read loop, which depends on the 

number of results being collected, the number of EVMs, and the user CPU.
• Although other registers can be read and written to through the register map page while collecting data, this 

can add a delay to the data being collected.

Auto Delay • Sets delay based on conversion times, averaging, and number of channels being converted.
• If multiple EVMs are used, the time put in the delay box is from the EVM with the shortest calculated delay 

value.

Save All Plots • Press the SAVE ALL PLOTS button to save the data for each currently selected result from the Results to 
collect or show section in a spreadsheet.

• Press the SAVE PLOT button next to each plot to save just the data from that plot in a spreadsheet.

Clear All Plots • Press the CLEAR ALL PLOTS button to clear the data from all plots together.
• Press the CLEAR PLOT button next to each plot to clear the data from just that plot.

#Samples • Change the number in this box to change the number of samples shown in each plot.
• Changing this number clears out the plot buffers, so the plots is cleared on the next read.

Y-Axis Options: Manual 
Scale

• Checking this box sets all EVM results in this plot to the same scale value specified by the Max and Min fields.
• When this is not selected, each EVM has a Y-axis scale based on the minimum and maximum result value for 

that EVM.

Y-Axis Options: Max • The maximum Y-axis value to use for all EVMs in this plot.
• If this field is empty when Manual Scale is selected, then the field automatically populates with the maximum 

value currently in the plot.

Y-Axis Options: Min • The minimum Y-axis value to use for all EVMs in this plot.
• If this field is empty when Manual Scale is selected, then the field automatically populates with the minimum 

value currently in the plot.
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3.2.3 Direct EVM USB Communication

If desired, the EVM can be communicated with directly without the use of the GUI through the USB port. This is 
done by sending the desired command string over the serial COM port and receiving the results either through 
the COM port or the USB BULK channel, based on the mode. This functionality is useful for interfacing the EVM 
with custom setups, scripts, or GUIs.

3.2.3.1 Standard USB Read and Write Operations

Use the serial COM port to read and write registers through USB commands using the formats specified in this 
section.

3.2.3.1.1 Set Device Address

To set the device address, use the following format: setdevice DEVID. Where setdevice is always lower case, 
and DEVID is the four LSBs of the address in decimal format (for example, for- an address of 0x4A, use 10).

Note that when the SCB is reset while one or more EVMs are connected, the address defaults to the lowest 
address found. The SCB checks for I2C or SPI at start up, if no device is attached, the SCB defaults to SPI. 
Reset the SCB with an I2C EVM connected to use I2C.

As an example, to set the INA233 with a register address of 0x4A, send the command: setdevice 10. For this 
example, the EVM returns the acknowledgment and states ("idle" or "collecting") in JSON format:

{"acknowledge":"setdevice 10"}
{"evm_state":"idle"}
3.2.3.1.2 Read Register

To read a register, use the following format: rreg ADR. Where ADRis the address in hex, and rreg is always 
lower case. Register addresses can be in upper or lower case, and do not need to be led by '0x'. Register 
addresses with 0 padding is also optional. For example, to read the register address 0xE0, some valid 
commands include:

• rreg e0
• rreg 00e0
• rreg 0xE0

When '0x' is used, the 'x' must be lower case. For this example, the EVM returns the result and states ("idle" or 
"collecting") in JSON format:

{"acknowledge":"rreg 0xE0"}
{"register":{"address":224,"value":21577}}
{"evm_state":"idle"}
3.2.3.1.3 Write to Register

To write to a register, use the following format: wreg ADR VAL. Where ADR and VAL are in hex, and wreg 
is always lower case. Register addresses can be in upper or lower case, and do not need to be led by '0x'. 
Register addresses with 0 padding is also optional. For example, to write to register address 0xD0 with the value 
0x4127, some valid commands include:
• wreg d0 4127
• wreg D0 0x4127
• wreg 0xD0 0x4127

When '0x' is used, the 'x' must be lower case.

For this example, the EVM returns the result and states ("idle" or "collecting") in JSON format:
{"acknowledge":"rreg 0xE0"}
{"register":{"address":224,"value":21577}}
{"evm_state":"idle"}
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3.2.3.2 Collect Data Through the USB BULK Channel 

The Collect Data function reads the desired result registers and sends the data based on the specified settings. 
This function works best with continuous conversion mode and does not configure the EVM or associated 
register settings. Collect mode is started and stopped using the serial COM port, however the results are sent 
over the USB BULK channel. To use this mode, use the following formats specified in this section.

3.2.3.2.1 Collect Data

To start collecting data, use the following format: collect timerPeriod collectFlags channelAddressIDs 
numDevices

Where collect is always lower case, and each parameter is the decimal representation of the value specified in 
Table 3-4.

Table 3-4. Collect Data Parameters
Parameter Description
timerPeriod The timer delay used in the MCU to allow data collection sample sets (in µs, unsigned 32bit value).

collectFlags A byte of data that has a 1 to collect and a 0 to not collect each register value type, according to the following 
definitions (Note, only use energy and charge flags when the device supports those flags, otherwise set to 0):
• VSHUNT = 0b10000
• ENERGY = 0b01000
• VBUS = 0b00100
• CURRENT = 0b00010
• POWER = 0b00001

channelAddressIDs The four LSBs of each I2C address chained together, starting with the LSBs. For example, if EVM 1 is at 
address 0x41 and EVM 2 is on ox43, the value of channelAddressIDs is: 0b00110001

NumDevices The number of EVMs chained together (1-4).

Using the information in Table 3-4 as an example, to start data collection for VSHUNT and VBUS every 2.2ms, 
for two INA233EVMs with EVM 1 address = 0x41 and EVM 2 address = 0x43, the data to send is: collect 2200 
20 49 2.

For this example, the EVM returns the acknowledgment and states in JSON format:
{"acknowledge":"collect 2200 20 49 2"}
{"evm_state":"collecting"}
3.2.3.2.2 USB BULK Receiving Data

The USB BULK channel receives data in the following format: frameID deviceNumID address registerSize data

Where each parameter is the decimal representation of the value in the following table.

Table 3-5. USB BULK Parameters
Parameter Description
frameID (1 byte) Always reads 0. Used to make sure data is aligned.

deviceNumID (1 byte) An ID number corresponding to the EVM number. From the preceding example, this number is 1 if reading 
from EVM 1, which has the address set to 0x41, and 2 if reading from EVM 2, which had a address set to 
0x43.

address (1 byte) The register address that is read from the device.

registerSize (1 byte) The number of bytes that the following data has.

data (1 byte at a time) The register data value, given in bytes with the most significant byte first.
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3.2.3.2.3 Stop Data Collection

To stop collecting data, use the following format: stop. Where stop is always lower case.

• The EVM returns the acknowledgment and states in JSON format:
{"acknowledge":"stop"}
{"evm_state":"idle"}

3.2.4 PAMB Compatibility

If desired, this EVM and GUI can be used with the PAMB Controller (DC081A) by using a jumper wire between 
the pin headers of the PAMB to the EVM. Figure 3-14 shows which pins on the PAMB correspond to the EVM 
header pins. Note, do not add too much resistance in the jumper wire connection setup or the signal can 
degrade and cause communication errors.

Figure 3-14. EVM to PAMB Connection
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4 Hardware Design Files

Note

Board layouts are not to scale. These figures are intended to show the board layout. The figures are 
not intended to be used for manufacturing EVM PCBs.

4.1 Schematics
Figure 4-1 and Figure 4-2 show the schematic of the INA233EVM. Figure 4-1 shows the circuitry for the EVM. 
Figure 4-2 shows the mechanical components included with the EVM.
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Figure 4-1. Schematic Circuitry
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Figure 4-2. Hardware Schematic
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4.2 PCB Layout
Figure 4-3 through Figure 4-6 illustrate the PCB layers of the INA233EVM.

Figure 4-3. Top View Figure 4-4. Top Layer

Figure 4-5. Bottom View Figure 4-6. Bottom Layer
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4.3 Bill of Materials
Table 4-1 provides the parts list for the INA233EVM.

Table 4-1. Bill of Materials
Designator Quantity Value Description PackageReference PartNumber Manufacturer

!PCB1 1 Printed Circuit Board INA233EVM Any

C1 1 1uF
CAP, CERM, 1 µF, 
16V,+/- 20%, X5R, 0402

0402 GRM155R61C105MA12D MuRata

C2, C4 2 0.1uF
CAP, CERM, 0.1uF, 50V, 
+/- 20%, X7R, 0402

0402 GRM155R71H104ME14D MuRata

D1, D2 2 White LED, White, SMD 0805 VAOL-S8WR4
Visual Communications 
Company LLC

H1, H2, H3, H4 4
Bumpon, Hemisphere, 
0.25X 0.075, Clear

75x250 mil SJ5382 3M

J1 1

TERM BLK 6POS SIDE 
ENTRY 5MM PCB 
ASSEMBLY NOTE: Trim 
leads per ZZ5

HDR6 6.91138E+11 Wurth Electronics

J2 1
Receptacle, 2mm, 6x2, 
Gold, R/A, TH

Receptacle, 2mm, 6x2, 
R/A, TH

NPPN062FJFN-RC
Sullins Connector 
Solutions

J3 1

Connector Header 
Through Hole, Right 
Angle 12 position 0.079" 
(2.00mm)

HDR12 NRPN062PARN-RC
Sullins Connector 
Solutions

R2, R3 2 0
RES, 0, 5%, 0.125 W, 
0603

0603 MCT06030Z0000ZP500 Vishay/Beyschlag

R4, R7, R9 3 10k
RES, 10k, 5%, 0.063W, 
AEC-Q200 Grade 0, 0402

0402 CRCW040210K0JNED Vishay-Dale

R5, R6 2 1.0k
RES, 1.0k, 5%, 0.063W, 
AEC-Q200 Grade 0, 0402

0402 CRCW04021K00JNED Vishay-Dale

R8 1 4.7k
RES, 4.7k, 5%, 0.063W, 
AEC-Q200 Grade 0, 0402

0402 CRCW04024K70JNED Vishay-Dale

SW0, SW1 2
Slide Switch SP4T 
Surface Mount, Right 
Angle

SMT_SW_11MM3_4MM1 CUS-14TB Nidec Copal Electronics
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Table 4-1. Bill of Materials (continued)
Designator Quantity Value Description PackageReference PartNumber Manufacturer

TP1, TP2, TP3, TP4, 
TP5, TP6, TP7, TP8, 
TP9, TP10, TP11, TP12

12
Test Point, Miniature, 
SMT

Testpoint_Keystone_Mini
ature

5015 Keystone

U1 1

High-Side or Low-
Side Measurement, 
Bi-Directional Current 
and Power Monitor 
with PMBus Compatible 
Interface, DGS0010A 
(VSSOP-10)

DGS0010A INA233AIDGSR Texas Instruments

U2 1
Single Buffer/Driver With 
Open-Drain Output, 
DBV0005A (SOT-23-5)

DBV0005A SN74LVC1G07DBVR Texas Instruments

C3 0 0.1uF
CAP, CERM, 0.1uF, 100V, 
+/- 10%, X7S, AEC-Q200 
Grade 1, 0603

0603
CGA3E3X7S2A104K080
AB

TDK

FID1, FID2, FID3 0
Fiducial mark. There is 
nothing to buy or mount.

N/A N/A N/A

LBL1 0

Thermal Transfer 
Printable Labels, 0.650" 
W x 0.200" H - 10,000 per 
roll

PCB Label 0.650x 0.200 
inch

THT-14-423-10 Brady

R1 0

10 mOhms ±0.5% 2W 
Chip Resistor 2512 (6432 
Metric) Automotive AEC-
Q200, Current Sense, 
Moisture Resistant Metal 
Film

2512 PCS2512DR0100ET Ohmite
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5 Additional Information
5.1 Trademarks
I2C™ is a trademark of I2C Technologies, Ltd.
myTI™ is a trademark of Texas Instruments.
Chrome™ is a trademark of Google LLC.
Firefox™ is a trademark of Mozilla Foundation in the U.S. and other countries.
Safari™ is a trademark of Apple Inc.
All trademarks are the property of their respective owners.
6 Related Documentation
The following is documentation related to the INA233 EVM.

• Texas Instruments, INA233 High-Side or Low-Side Measurement, Bidirectional Current and Power Monitor 
With I 2C-, SMBus-, and PMBus-Compatible Interface, datasheet

• Texas Instruments, Getting Started with Digital Power Monitors, application note
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING
Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers

and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI’s instructions for

electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

http://www.ti.com
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Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。 

https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-delivered-in-japan.html
3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified

by TI as conforming to Technical Regulations of Radio Law of Japan.
If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧くださ
い。https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-for-power-line-communication.html

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

http://www.ti.com
https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-delivered-in-japan.html
https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-for-power-line-communication.html
https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-for-power-line-communication.html
https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-delivered-in-japan.html


www.ti.com

4

4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

http://www.ti.com
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8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265 
Copyright © 2023, Texas Instruments Incorporated

http://www.ti.com


IMPORTANT NOTICE AND DISCLAIMER
TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE 
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS” 
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD 
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate 
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable 
standards, and any other safety, security, regulatory or other requirements.
These resources are subject to change without notice. TI grants you permission to use these resources only for development of an 
application that uses the TI products described in the resource. Other reproduction and display of these resources is prohibited. No license 
is granted to any other TI intellectual property right or to any third party intellectual property right. TI disclaims responsibility for, and you fully 
indemnify TI and its representatives against any claims, damages, costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale, TI’s General Quality Guidelines, or other applicable terms available either on 
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable 
warranties or warranty disclaimers for TI products. Unless TI explicitly designates a product as custom or customer-specified, TI products 
are standard, catalog, general purpose devices.
TI objects to and rejects any additional or different terms you may propose.
IMPORTANT NOTICE

Copyright © 2026, Texas Instruments Incorporated

Last updated 10/2025

https://www.ti.com/legal/terms-conditions/terms-of-sale.html
https://www.ti.com/lit/pdf/SZZQ076
https://www.ti.com
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